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  البرنامج الزمني للدورة

  اليوم
  )WaterCADبرنامج (المحاضرة 

  الثالثة  الثانية  الأولى

  الأول

 تقديم وتعارف  
 تعريف الغرض من الدورة 

  توزيع استمارات تقييم المشاركين في
مجالات الهيدروليكا و مهارات 

 الكمبيوتر

 إنشاء مشروع جديد 

 بناء  الشبكة 

 التأكد من صحة رسم الشبكة  

 ن رسم الشبكةتمري 

 إعداد البيانات المطلوبة للبرنامج 

 إدخال البيانات 

 Model Builder 

 Trex  

 Thiessen Polygon 

 Load Builder 

 تمرين إدخال البيانات 

  

  الثاني

 أوامر مساعدة 

color coding –annotation 
selection set‐ zone –active 

topology 

  

   إجراء التحليل الهيدروليكيSteady State 

 استعراض النتائج 

  تمرين علي إجراء التحليل الهيدرليكي 

Steady State  

 استعراض النتائج 

  أنماط الاستهلاك وPattern  
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  الثالث

 إجراء التحليل الهيدروليكيExtended 

Period  وعلاقة الخزانات العالية بذلك  
  

 استعراض النتائج والمنحنيات 

  تمرين علي  إجراء التحليل
واستعراض  Extended Periodالهيدروليكي

  النتائج والمنحنيات

 في حالة  إجراء التحليل الهيدروليكي
  Fire Flow analysisالحريق 

 تحكم على عناصر نموذج الشبكة  

  الرابع
 تطبيقات على رسم الشبكة وتصحيحها 

 السيناريوهات والبدائل  
  تطبيقات على إدخال البيانات وعمل

  السيناريوهات
  ليل التح إجراءتطبيقات على

  الهيدروليكي واستعراض النتائج

  الخامس
 توزيع وملء استمارات تقييم الدورة 

  المستقبليالتحضير للعمل   
 اختبار عملي   استكمال الاختبار العملي  
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WaterCADاستخدام برنامج  V8I  لتصميم
شبكات مياه الشرب 

٢٠١١أآتوبر  

مشروع دعم قطاع مياه الشرب و الصرف الصحي

  

  

 

  

WaterCAD V8I

WaterCAD V8I is one of Bentley 
products unveiled on 2008, which 
has added a vast range of  modeling 
tools to elaborate the interface 
between watercad and other 
drafting and database programs like 
autocad, ARC GIS ,Microsoft 
Excel, and Microsoft Acess,…..etc.
such tools have enabled more 
flexibility and simplicity in dealing 
with data entry load building  and 
applying various scenarios 
alternatives.     
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Course Schedule
no Title
1 Introduction
2 Network Elements , Patterns and Controls
3 Steady State
4 Extended period
5 Results Presentation
6 Fire Flow
7 Scenarios and Alternatives
8 GIS Applications & Advanced Features
9 Evaluation Exam

10 Review and Discussion

  

WaterCAD Program
WaterCAD is a rich program that used to 
analyze the water networks, Our goals is 
to provide you with the content in the 
best possible way. Our course includes 
information about the WaterCAD
interface, features and contains tutorials 
and the theory on which the WaterCAD is 
based.

Both the WaterCAD Stand-Alone 
interface and the AutoCAD interface 
have many components common to 
Windows-based programs. The following 
slides illustrate some of the important 
features in WaterCAD

WaterCAD Interface
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 Steady-state analysis to simulate the system behavior at certain time.

 Extended period simulations (EPS) over a period of time

 Water quality simulations to track the growth or decay of a certain 
chemical such as residual chlorine throughout the network.
(only works with EPS analysis)

 Fire Flow Analysis on your system to determine the system behavior 
under extreme conditions.
(only works with Steady State analysis)

 Calibration Analysis is used to adjust the WaterCAD model to better 
match the actual behavior of the water distribution system by using the 
Darwin Calibrator feature. It allows you to make manual adjustments on 
the model as well as adjustments using genetic algorithm optimization.

Network Analysis Types
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Procedure for Hydraulic Analysis
Prepare a background drawing

Layout network elements

Distribute water demand

Assume network data

Carry out the analysis

Assess results

Present results

(Pipe diameters, Tank sizes & 
heights, Pump flow & heads)

OK

Not 
OK

(Steady State / EPS)

(Average + pattern, Or 
Peak)

(Pressures, velocities, gradient 
slopes, Tanks & Pumps 
Performance
(Pipe report, Junction report, 
Tank graphs)

(Scaled DXF file or 
Shapefiles)

(Pipes, Junctions, Pumps, 
Reservoirs, Tanks & Valves)

  

  

SHP files

MDB files

DXF files

WTG files

Database 
Software

WaterCAD

GIS Software CAD 
Software

INP files

EPAnet
Software

Tables & 
Graphs

Office Software

Engineering 
Libraries

SCADA 
SCA files

WaterCAD I/O Files

XLS files

Excel sheets 
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Engineering Library Manager

Components > Engineering Library

Engineering Libraries are used to manage specifications of common materials, 
objects, or components that are shared across projects such as: 
 Constituent Properties (chemical dissolved in water)
 General purpose valve(GPV) Head Loss Curve
 Liquid Properties (water, Seawater, …etc)
 Pipe Material Properties (DI, concrete, steel,  ..etc)
 Minor Loss (K value for bends, tees, valves, … etc)
 Demand Pattern (hourly, daily, monthly)
 Pressure Dependent Demand Function
 Pump Definition
 Unit Demand 
 Valve Characteristics

Project Setup

  

  

Project Setup
Units

Tools > Options > Units tab 
Modifies the unit settings for the current project (SI or US)

Friction Method 
Analysis > Calculation > Options Friction Method

Set the global friction method (Hazen-Williams, Darcy, 
Colebrook,..etc).

Prototypes
View > Prototypes

Prototypes allow you to enter default values for elements in your 
network. These values are used while laying out the network. 
Prototypes can reduce data entry requirements dramatically if a group 
of network elements share common data.
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Project Preparation

Demand 
Get the population for the city then calculate the population in the future 
From table 1-4 in Egyptian code for water and wasterwater networks to get the 
water consumption
Qav= W.C*POP 

Design flows
From table 1-6 in Egyptian code for water and wasterwater networks to get the 
water consumption
Qmd= Qav*PFmd

Qmh= Qav*PFmh

Fire flow
go to code table 1-7 to get the fire flow and fire period

  

Pipes

J-5J-4 L, D, C, K

Q, V, S, H P-3

Pipes are link elements that connect junction nodes, pumps, valves, 
tanks, and reservoirs to each other.

Input Data Output Data

Diameter (D) Flow Rate (Q)

Length (L) – Scaled or User Defined Velocity (V)

Friction Losses Coefficient (C) Gradient Slope (S)

Minor Losses Coefficient (K)

Pipe Material with its associated roughness 
value, selected from the Material Library.

Status (Open or Closed)
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Junctions and Hydrants

Demand 
(Outflow)

Inflow

Elevation (Z)

Hydraulic Gradient Line 

Datum

Pressure (P)

HG = Z + P

J-5

Junctions and hydrants are non-storage nodes 
where water can leave the network to satisfy 
consumer demands, 

Water can also enter the network as an inflow.

Junction can also be used to model hydrants 
with an emitter coefficient (see Hydrants).

Chemical constituents can enter the network 
through junctions and hydrants

Input Data Output Data

Elevation Hydraulic Gradient

Demand / Inflow Pressure

Demand Pattern

Zone

  

  

The Demand Control Center is an editor for manipulating all the demands 
in your water model. Using the Demand Control Center, you can add new 
demands, delete existing demands, or modify the values for existing 
demands using standard SQL select and update queries. 

The Demand Control Center provides demand editing capabilities which 
can: 
 open on all demand nodes, or subset of demand nodes,
 sort and filter based on demand criteria,
 add, edit, and delete individual demands,
 global edit demands,
 and filter elements based on selection set, attribute, or predefined 

query.

Demand Control Center 
Tools > Demand Control Center 
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The Unit Demand Control Center is an editor for manipulating all the unit 
demands in your water model. 

Using the Unit Demand Control Center, you can add new unit demands, 
delete existing unit demands, or modify the values for existing unit 
demands. 

Unit Demand Control Center 
Tools > Unit Demand Control Center

  

  

Demand Patterns

Each junction could have a number of base flows (loads)

Base flow could either be a demand or an inflow.

Each flow can have a fixed or different EPS pattern. The multipliers defined in the 
pattern will be applied against the baseline load.

The EPS Pattern is not considered during Steady State Simulations the demand 
baseline load will be used instead.
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Reservoirs
Reservoirs are storage nodes. 

The water surface elevation of a reservoir does 
not change as water flows into or out of it during 
an extended period simulation, unless an HGL 
Pattern has been applied to the reservoir. 

Reservoirs can be used to model external water 
sources such as lakes, streams, and wells.

Input Data Output Data

Elevation (Hydraulic Grade) Outflow (Q)

Elevation
(Hydraulic Grade)

Qout

  

Tanks
Tanks are storage nodes. The water surface 
elevation of a tank will change as water flows into 
or out of it during an extended period simulation. 

For steady-state simulations, a tank is considered 
to have a constant water surface elevation, similar 
to a reservoir.

Elevation

Base Elevation

Min. W.L.

Max. W.L.

Initial W.L.

Inactive 
Volume

Active 
Volume

Inflow / 
Outflow

Demand / 
Inflow 

Input Data Output Data

Elevation (G.L.) Active Volume

Cross Section Area Hydraulic Grade

Base Elevation

Min. Elevation (Level)

Initial Elevation (Level)

Max. Elevation (Level)
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Pumps
Pumps are elements that add head to 
the system as water passes through it. 

Pumps add energy (head gains) to the 
flow, to counteract head losses and 
hydraulic grade differentials within the 
system.

H1

H2

H=H2-H1

Elevation Q

Input Data Output Data

Elevation (G.L.) Duty (Operating) Point (Q, H)

Pump Curve (Q-H)

Pump Type 
(Fixed or Variable Speed)

VSP Pattern

  

  

Pump Curve

Design Point (One-
Point)

A pump can be defined by a single design point (Hd @ Qd).  
WaterCAD assumes Ho = 1.33•Hd and Qo = 2.00•Qd.

Standard (Three-
Point)

This pump curve is defined by three points - the shutoff head, the 
design point, and the maximum operating point. 

Standard Extended The same as the standard three-point pump, but with an extended 
point at the zero pump head point.

Custom Extended The custom extended pump is similar to the standard extended 
pump, but allows you to enter the discharge at zero pump head.

Multiple Points The pump curve is defined by entering points for discharge rates at 
various heads. 

Constant Power Based on power-head-flow rate relationships for pumps, the 
operating point of the pump can then be determined.

A pump is defined by its characteristic 
curve, which relates the pump head, or 
the head added to the system, to the flow 
rate.  
The system operating point is based on 
the point at which the pump curve 
crosses the system curve representing 
the static lift and head losses due to 
friction and minor losses. 

HS

HL

Pump 
Curve

H 

Q 

Operating 
Point

System 
Curve
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Valves
Valves are elements that open,
throttle, or close to satisfy a
condition which is set by the
user.

Upstream 
Head H1

Q 

Downstream 
Head H2

Valve 

H = H1 – H2 

Valve Type Setting
Pressure Reducing Valve (PRV) H2 (max)

Pressure Sustaining Valve (PSV) H1 (min)

Pressure Breaker Valve (PBV) H1-H2

Flow Control Valve (FCV) Q (max)

Throttle Control Valve (TCV) K

General Purpose Valve (GPV) Q – H

Isolation Valve Allows or disallows 
flow through a pipe

Input Data Output Data

Elevation (G.L.) Discharge

Diameter Velocity

Type Head Loss (H)

Setting H1 and H2

  

   



  إنترناشيونال كيمونكس   مصر في الصحي والصرف الشرب مياه قطاع دعم مشروع

 

 ٢٠  في تصميم شبكات مياه الشرب   (WaterCAD V8i)استخدام برنامج 

 

Patterns provide an effective means of applying time-variable system demands to the 

distribution model. The Pattern Manager allows you to create the following types of 

patterns:

Hydraulic - This type of pattern can be applied to Junctions or Tanks. Use this pattern 

type to describe demand or inflow patterns over time.

An individual demand node can support multiple demands. Furthermore, each demand 

can be assigned any hydraulic pattern. This powerful functionality makes it possible to 

model any type of extended period simulation.

Patterns

  

Patterns

Hourly patterns consist of a number of time step points, defined below

• Time from Start - The amount of time from the Start Time of the 

pattern to the time step point being defined.

• Multiplier - The multiplier value associated with the time step point.

Daily and Monthly factors are defined in the same way as hourly ones, 

the difference being that rather than defining time steps you enter 

multipliers for each day of the week (for Daily patterns) or for each 

month of the year (for monthly patterns). 
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Each junction could have a number of base flows (loads)

Base flow could either be a demand or an inflow.

Each flow can have a fixed or different EPS pattern. The multipliers defined in the pattern 
will be applied against the baseline load.

The EPS Pattern is not considered during Steady State Simulations the demand baseline load 
will be used instead.

Demand Patterns
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The Control Manager allows you to take ACTIONS regarding the the operation of 
your network (pumps, valves) based on predefined CONDITIONS that may 
happen.  

The Control Manager consists of the following tabs: 

Controls—Manage all controls defined in the system. 

Conditions—Define the condition that must be met prior to taking an action.

Actions—Define what should be done to an element in the system in response to 
an associated control condition.

Control Sets—Assign groups of controls to Control Sets.

Controls
Components > Controls 
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Simple Controls
Simple controls are made up of an IF condition and a THEN action statement.

IF Condition 1 
THEN Action 1 

Logical Controls
Logical controls are made up of an IF condition, a THEN action, and an optional 
ELSE action, 

IF Condition 1 
THEN Action 1
ELSE (Optional) Action 2

Control Types

Control Sets
A Control Set is made up of one or more Controls.  The Control Sets tab allows 
you to create, modify and manage control sets. Control sets are a way to 
organize your controls, and also provide the means to use different controls in 
different scenarios. 

  

  

Control Types
The Controls tab is divided into sections:

Evaluate as Simple Control - Turn on in order to evaluate the condition as a 
simple control.

IF Condition - The drop-down list allows you to choose from a list of conditions 
that have already been created in the Conditions tab.
THEN Action - The drop-down list allows you to choose from a list of actions 
that have already been created in the Actions tab.

ELSE Action (optional) - used when the conditions for the control are not met. 
Click the check box to activate the drop-down list. The drop-down list allows 
you to choose from a list of predefined actions.

Priority – Optional to set a priority for the control being created, turn on to 
activate the priority drop-down list. You can set a priority of 1-5, 5 being the 
highest priority. If multiple controls meet a certain condition and they have 
conflicting actions, the control with the highest priority will be used.
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Control Conditions
Conditions allow you to define the condition that must be met prior to taking an action. 
There are two types of conditions: simple conditions and composite conditions. Composite 
conditions are composed of a number of simple conditions.

A control can be triggered by a specified Element condition, System demand condition, or 
Time condition.

Element - This will create a condition based on specified attributes at a selected element. 
The attributes available when this condition type is selected depend on the element type 
(junction, tank, pump,  etc). 

System Demand - This will create a condition based on the demands for the entire 
system. 

Clock Time - This will create a condition based on the clock time during an extended 
period simulation. If the extended period simulation is for a period longer than 24 hours, 
this condition will be triggered every day at the specified time. 

Time from Start - This will create a condition based on the amount of time that has passed 
since the beginning of an extended period simulation. 

  

  

Control Actions
Actions allow you to define what should be done to an element in the system in 
response to an associated control condition. The Actions tab provides a list of all 
actions defined in the system. 

There are two types of actions: simple actions and composite actions. 
Composite logical actions consist of multiple simple logical actions. These 
actions are linked with an AND statement.  

The Element field allows you to specify which element the action will be based 
upon. The attributes available when this condition type is selected depend on 
the element type (junction, tank, pump,  etc).

Controls support two types of actions: 

Status - Controls the Open/Closed (pipes), Inactive/closed (valves), On/Off 
(pumps) status.

Setting - Controls the relative speed factor of a pump, The parameters for a 
valve.
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Results Presentation
FlexTables

View > FlexTables

Using FlexTables you can view input data and results for all elements of a 
specific type in a tabular format. You can use the standard set of FlexTables or 
create customized FlexTables to compare data and create reports. 

You can view all elements in the project, all elements of a specific type, or any 
subset of elements. Additionally, to ease data input and present output data for 
specific elements, FlexTables can be: 

• Filtered
• Globally edited 
• Sorted. 

FlexTables can also be used to create results reports that you can print, save as 
a file, or copy to the Windows clipboard for copying into word processing or 
spreadsheet software. 

  

  

Results Presentation
Graphs 

View > Graphs
Use graphs to visualize your model or parts of your model, such as element 
properties or results. After the model has been calculated, you can graph 
elements directly from the drawing view.

Profiles
View > Profiles

A profile is a graph that plots a particular attribute across a distance, such as 
ground elevation along a section of piping.  

Contour 
View > Contours

The Contour Map Manager contains the information required to generate 
contours for a calculated network.
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Results Presentation
Color Coding

View > Element Symbology > New Color Coding 
Color Coding allows you to assign colors to elements in the drawing based on a 
variety of input and output attributes.  
You may add a color coding legend to the drawing. This legend is automatically 
updated as the color coding is modified.

Element Annotation
View > Element Symbology > New Annotation

Element annotations allow you to display detailed information such as pipe 
lengths or node ground elevations, as well as calculated values such as velocity, 
in your drawing.  
You can add one or more annotations for any type of element in the system.  
Annotations update automatically.  For example, annotations will display newly 
calculated values and will be refreshed as you change scenarios.  

Drawing Annotation
Tools > Layout > Line / Border / Text

There are several tools for adding annotations to your drawing. Annotations are 
not network elements, but can be selected for editing and moving in the drawing. 

  

  

Results Presentation
Element Relabeling

Flex Tables > Relabel
Element relabeling allows you to modify the labels of a selected set of 
elements.  With element relabeling, you can quickly append a prefix such as 
‘P-’ to all pipes in your system so that it is obvious which labels belong to 
elements representing pipes.

Selection Sets 
View > Selection Sets

Selection sets are user-defined groups of network elements. They allow you 
to predefine a group of network elements that you want to manipulate 
together. You manage selection sets in the Selection Sets Manager. 

Reporting 
Use reporting to create printable content based on some aspect of your 
model, such as element properties or results. 
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Results Assessment
Parameter Limit

Velocity < 2.0 m/s

Gradient slopes < 5.0 m/km

Diameters Upstream > Downstream

Pressures 2.0 to 6.0 bars

Tanks

Filling and emptying

End capacity >= Start capacity

Never empty

Pumps Operating near design point

  

  

Results Presentation
Label

Length 
(m)

Diameter 
(mm)

Discharge 
(L/s)

Velocity 
(m/s)

Headloss
Gradient 
(m/km)

Headloss
(m)

P-2 1,069 800 243.7 0.48 0.28 0.3

P-3 1,466 600 169.8 0.6 0.59 0.86

P-4 1,327 400 126.8 1.01 2.46 3.26

P-5 1,088 300 11.3 0.16 0.11 0.12

P-6 435 300 37.6 0.53 1.05 0.46

P-7 908 250 69 1.41 7.86 7.14

Pipe Report

Junction Report Label
Elevation 

(m)
Base Flow 

(L/s)
Demand 

(L/s)

Calculated 
Hydraulic 
Grade (m)

Pressure (m 
H2O)

J-5 61 31 62 120.98 59.9

J-6 63 31 62 120.68 57.6

J-7 67 31 62 119.82 52.7

J-8 69 31 62 116.56 47.5

J-9 71 31 62 116.68 45.6

J-10 71 31 62 116.22 45.1

(At Peak Demand)

(At Peak Demand)
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Results Presentation - Pumps
Discharge versus Time

Pump: PMP-1

Time
(hr)

(l
/s

)
D

is
c
h
a
rg

e

300.0

400.0

500.0

600.0

700.0

800.0

900.0

1000.0

1100.0

0.0 4.0 8.0 12.0 16.0 20.0 24.0

PMP-1\Base

Head

Flow Rate

Pump Head versus Time
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Results Presentation - Tanks

Calculated Percent Full versus Time
Tank: T-2
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Calculated Volume versus Time
Tank: T-3
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Optimal Tank Base Elevation

Qmin

Qmax

HGL

Tank

Reservoir
Pipes

شبكة التوزيع

PS

H

  

  

Post-Analysis Calculations

Totalizing Flow Meter 

Analysis > Totalizing Flow Meter  or (Alt+4)

Totalizing flow meters allow you to view results of the total volume going through your 
model for a specific selection of elements.  Only available in EPS mode

• Create a new totalizing flow meter.
• Select the elements to be calculated.
• Set Start and Stop times. Once selected, the results are automatically updated.
• The Totalizing Flow Meter Summary tab displays the totals for each element 

type. 
• The Totalizing Flow Meter Details tab displays results for each individual 

element.
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Post-Analysis Calculations
Hydrant Flow Curves 

Analysis > Hydrant Flow Curve or  (Alt+5)

Hydrant flow curves allow you to find the flow the distribution system can deliver at 
the specified residual pressure, helping you identify the system's capacity to deliver 
water at certain junction or hydrant in the network. 

Hydrant Flow Curve
H 

Q 

 Select the junction or hydrant to be used for 
the hydrant flow curve

 Enter values for Nominal Hydrant Flow and 
Number of Intervals in the corresponding 
fields.

 Select a time step (in EPS mode)
 Click the Compute button to calculate the 

hydrant flow curve.
 View the results as a graph, data or report.

  

  

Post-Analysis Calculations
System Head Curve
Analysis > System Head Curve or (Alt+6)
The System Head Curve editor allows you to define and calculate a graph 
of head vs. flow that shows the head required to move a given flow rate 
through the selected pump and into the distribution system.

Duty Point

H 

Q 

System Curve
Pump Curve

 Select the pump that will be used for the 
system head curve.

 Type a value for Maximum Flow and 
Number of Intervals.

 Select a time step (EPS mode).
 Compute to calculate the results for the 

specified time step.
 View the results as a graph, data or report.
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Fire Flow Analysis

Needed Fire 
Flow

The flow rate required at the junction to meet fire flow demands. This 
value will be added to or replace the junction’s baseline demand, 
depending on the default setting for applying fire flows as specified in the 
Fire Flow Alternative dialog.

Fire Flow 
Upper Limit

This input defines the maximum allowable fire flow that a junction can 
provide and the maximum allowable fire flow that can occur at any single 
withdrawal location. 

Residual 
Pressure

Minimum residual pressure to occur at the junction node. The program 
determines the amount of fire flow available such that the residual 
pressure at the junction node does not fall below this target pressure

Minimum 
Zone 
Pressure

Minimum pressure to occur at all junction nodes within the Zone you are 
testing.  The model determines the available fire flow such that the 
minimum zone pressures do not fall below this target pressure. 

Minimum 
System 
Pressure

Minimum pressure allowed at any junction in the entire system as a result 
of the fire flow withdrawal.  If a node’s pressure anywhere in the system 
falls below this constraint while withdrawing fire flow, fire flow will not be 
satisfied.  A fire flow analysis may be configured to ignore this constraint.

Fire flow analysis is only available in the Steady State Analysis mode.  Fire flows can be 
computed for a single node, a group of selected nodes, or all nodes in the system. A 
complete fire flow analysis is carried out for each junction selected for the fire flow analysis

The fire flow input data for a junction are as follows:

  

  

Fire Flow Results
Data Description
Satisfies Fire Flow 
Constraints

Whether the selected junction node meets the fire flow 
constraints

Available Fire 
Flow

Amount of flow available for fire protection while 
maintaining all fire flow pressure constraints

Calculated 
Residual Pressure

Calculated pressure at the junction node during the fire 
flow withdrawal

Calculated 
Minimum Zone 
Pressure

Minimum calculated pressure of all junctions in the 
same zone as this junction

Minimum Zone 
Junction

Label of the junction corresponding to the minimum 
zone pressure

Calculated 
Minimum System 
Pressure

Minimum calculated pressure of all junctions in the 
system.

Minimum System 
Junction

Label of the junction corresponding to the minimum 
system pressure.
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Fire Flow Checks
Perform the following checks if you are not getting expected fire flow results:

1. Check the Available Fire Flow.  If it is lower than the Needed Fire Flow, the fire flow 
conditions for that node are not satisfied.  Therefore, Satisfies Fire Flow Constraints is 
false.

2. Check the Calculated Residual Pressure.  If it is lower than the Residual Pressure 
Constraint, the fire flow condition for that node is not satisfied.  Therefore, Satisfies Fire 
Flow Constraints is false.

3. Check the Calculated Minimum Zone Pressure.  If it is lower than the Minimum Zone 
Pressure Constraint, the fire flow condition for that node is not satisfied.  Therefore, 
Satisfies Fire Flow Constraints is false.

Note:  If you are not concerned about the pressure of a node that is NOT meeting the Minimum 
Zone Pressure constraint, move this node to another zone.  Now, the node will not be 
analyzed as part of the same zone.

4. If you checked the box for Minimum System Pressure Constraint in the Fire Flow 
Alternative dialog, check to see if the Calculated Minimum System Pressure is lower than 
the set constraint.  If it is, Satisfies Fire Flow Constraints is False.

  

  

Scenarios and Alternatives
Scenarios and alternatives allow you to create, analyze, and recall an 
unlimited number of variations of your model.  The scenario 
management feature allows you to easily analyze and recall an 
unlimited number of "What If?" calculations for your model.
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Alternatives
Alternatives are the building blocks behind scenarios.  They are categorized data sets 
that create scenarios when placed together.  Alternatives hold the input data in the 
form of records.  A record holds the data for a particular element in your system.  The 
different types of alternatives are as follows: 

Active Topology, Physical, Demand, Initial Settings, Operational, Age, Constituent, 
Trace, Fire Flow, Energy Cost, and Pressure Dependent Demand

There are two kinds of alternatives:
• Base alternatives contain local data for all elements in your system.  
• Child alternatives inherit data from base alternatives, or even other child 

alternatives, and contain data for one or more elements in your system.  The data 
within an alternative consists of data inherited from its parent, and the data 
altered specifically by you (local data).

All data inherited from the base alternative will be changed when the base alternative 
changes.  
Only local data specific to a child alternative will remain unchanged.
All data in child alternative can be moved to the parent alternative by merging.

  

  

Scenarios
Scenarios are composed of alternatives, as well as other calculation options, allowing 
you to compute and compare the results of various changes to your system.  
Alternatives can vary independently within scenarios, and can be shared between 
scenarios.

Scenarios allow you to specify the alternatives you wish to analyze.  In combination with 
scenarios, you can perform calculations on your system to see what effect each 
alternative will have.  Once you have determined an alternative that works best for your 
system, you can permanently merge changes from the preferred alternative to the base 
alternative if you wish.

There are two types of scenarios: 
• Base Scenarios - Contain all of your working data. When you start a new project, 

you begin with a default base scenario. As you enter data and calculate your model, 
you are working with this default base scenario and the alternatives it references.

• Child Scenarios - Inherit data from a base scenario or other child scenarios. Child 
scenarios allow you to freely change data for one or more elements in your system. 
Child scenarios can reflect some or all of the values contained in their parent. This 
is a very powerful concept, giving you the ability to make changes in a parent 
scenario that will trickle down through child scenarios, while also giving you the 
ability to override values for some or all of the elements in child scenarios.

  

  

  



  إنترناشيونال كيمونكس   مصر في الصحي والصرف الشرب مياه قطاع دعم مشروع

 

 ٣٣  في تصميم شبكات مياه الشرب   (WaterCAD V8i)استخدام برنامج 

 

GIS Applications & Advanced Features
Active Topology 

Tools > Active Topology Selection

The Active Topology Alternative allows you to temporarily remove areas of the 
network from the current analysis. This is useful for comparing the effect of 
proposed construction and to gauge the effectiveness of redundancy that may 
be present in the system.  Inactive elements are not included in any hydraulic 
analysis. 

  

  

GIS Applications & Advanced Features
ModelBuilder 

Tools > ModelBuilder
ModelBuilder lets you use your existing GIS asset to construct a new Bentley 
WaterCAD model or update an existing Bentley WaterCAD model. ModelBuilder 
supports a wide variety of data formats, from simple databases (such as Access and 
DBase), spreadsheets (such as Excel or Lotus), GIS data (such as shape files), to 
high end data stores (such as Oracle, and SQL Server), and more. 
Using ModelBuilder, you map the tables and fields contained within your data source 
to element types and attributes in your Bentley WaterCAD model. The result is that a 
Bentley WaterCAD model is created. ModelBuilder can be used in any of the Bentley 
WaterCAD V8 XM Edition platforms - Stand-Alone, MicroStation mode, AutoCAD 
mode, or ArcGIS mode. 
The ModelBuilder wizard assists in the creation of ModelBuilder connections. The 
Wizard will guide you through the process of selecting your data source and mapping 
that data to the desired input of your model. 
There are 4 steps involved: 
 Step 1—Specify Data Source
 Step 2—Specify Spatial Options
 Step 3—Specify Field Mappings for each Table/Feature Class
 Step 4—Build Operation Confirmation
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GIS Applications & Advanced Features
TRex
Tools > TRex
The TRex Terrain Extractor can quickly and easily assign elevations to 
any or all of the nodes in the water distribution model. All that is required 
is a valid Digital Elevation Model. Data input for TRex consists of: 
 Specify the file from which elevation data will be extracted.
 Specify the measurement unit associated with the data (feet, 

meters, etc.).
 Select the model features to which elevations should be applied; all 

model features or a selection set of features can be chosen.
TRex then interpolates an elevation value for each specific point 
occupied by a model feature. The final step of the wizard displays a list 
of all of the features to which an elevation was applied, along with the 
elevation values for those features. These elevation values can then be 
applied to a new physical properties alternative, or an existing one. In 
some cases, you might have more accurate information for some nodes 
(e.g., survey elevation from a pump station). In those cases, you should 
create the elevation data using DEM data and manually overwrite the 
more accurate data for those nodes.

  

  

GIS Applications & Advanced Features
LoadBuilder

Tools > Loadbuilder

The LoadBuilder wizard assists you in the creation of a new load build template by 
stepping you through the procedure of creating a new load build template. 
The available load methods are as follows: 

Allocation 
 Billing Meter Aggregation—This loading method assigns all meters within a 

service polygon to the specified demand node for that service polygon. 
 Nearest Node—This loading method assigns customer meter demands to the 

closest demand junction. 
 Nearest Pipe—This loading method assigns customer meter demands to the 

closest pipe, then distributes demands using user-defined criteria. 
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GIS Applications & Advanced Features
LoadBuilder
Distribution 
Equal Flow Distribution—This loading method equally divides the total flow 
contained in a flow boundary polygon and assigns it to the nodes that fall within the 
flow boundary polygon. 
Proportional Distribution by Area—This load method proportionally distributes a 
lump-sum flow among a number of demand nodes based upon the ratio of total 
service area to the area of the node's corresponding service polygon. 
Proportional Distribution by Population—This load method proportionally 
distributes a lump-sum demand among a number of demand nodes based upon the 
ratio of total population contained within the node's corresponding service polygon. 
Unit Line—This load method divides the total demand in the system (or in a section 
of the system) into 2 parts: known demand (metered) and unknown demand (leakage 
and unmeasured user demand).
Projection
Projection by Land Use—This method allocates demand based upon the density 
per land use type of each service polygon. 
Load Estimation by Population—This method allocates demand based upon 
user-defined relationships between demand per capita and population data

  

  

GIS Applications & Advanced Features
LoadBuilder

Thiessen Polygon Creator Dialog Box 
The Thiessen Polygon Creator allows you to quickly create polygon layers for 
use with the LoadBuilder demand allocation module. This utility creates 
polygon layers that can be used as service area layers for the following 
LoadBuilder loading strategies: 
Billing Meter Aggregation
Proportional Distribution By Area
Proportional Distribution By Population
Projection by Land Use
Load Estimation by Population.
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  التمرين الأول

  :الأتيمنطقة سكنية جديدة مطلوب رسم وتصميم الشبكات الرئيسية مع مراعاة 
 المساحة وان الكثافة ثابتة أساس ىتوزيع التصرفات علي النقاط المختلفة عل 
  المناسيب للمدينة مخزنه بملفdwg 
  د خزان عالي حالة عدم وجو فيتصميم الشبكة والطلمبات)(Steady State  
  المختلفةحاله وجود خزان عالي مع إيجاد المناسيب  فيتصميم الشبكة والطلمبات 

  للخزان  
 التأكد من صلاحية الشبكة للوفاء بمتطلبات الحريق 
 للمدينة لهذه المستقبل في المياه من والاستهلاكات السكان يوضح) ١( رقم الجدول بان علما

 

area Population
Water 

Consumption
Qav  Qmd  Qhr  

Hectares Capita (L/Capita/day)(L/s) (L/s) (L/s) 

58.8 30000 150 52.08 83.33 130.21 

 

  الحالى الوقت فى المياه من والاستهلاكات السكان يوضح) ٢( رقم الجدول

area Population
Water 

Consumption
Qav  Qmd  Qhr  

Hectares Capita (L/Capita/day)(L/s) (L/s) (L/s) 

58.8 20000 150 34.72 55.56 86.81 
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   الاستهلاك أنماط يوضح) ٣( رقم الجدول

 ١٢:٠٠ ١٠:٠٠  ٨:٠٠  ٦:٠٠ ٤:٠٠ ٢:٠٠ ٠٠:٠٠  الساعة

النسبة من 

متوسط 

  استهلاك المياه

٢.٥  ٢.٢٣  ١.٧٣  ١.٤٠  ١.٠٩  ٠.٨٥  ٠.٧٠  

 ٢٤:٠٠ ٢٢:٠٠ ٢٠:٠٠ ١٨:٠٠ ١٦:٠٠ ١٤:٠٠ ١٢:٠٠  الساعة

النسبة من 

متوسط 

  استهلاك المياه

٠.٧٠  ١.٢٠  ١.٦٥  ١.٧٥  ١.٨  ٢.٣  ٢.٥  

  

Fire Flow Demand (l/s) =30 l/s 
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  ثانيال التمرين

  :منطقة سكنية جديدة مطلوب رسم وتصميم الشبكات الرئيسية مع مراعاة الأتي
 توزيع التصرفات علي النقاط المختلفة على أساس المساحة و الكثافات المعطاة 
  المناسيب للمدينة مخزنه بملفdwg 
  ي حالة عدم وجود خزان عال فيتصميم الشبكة والطلمبات)(Steady State  
  وجود خزان عالي مع إيجاد المناسيب المختلفة  ةحال فيتصميم الشبكة والطلمبات

  للخزان  
 التأكد من صلاحية الشبكة للوفاء بمتطلبات الحريق 
   المدينة لهذه المستقبل في المياه من والاستهلاكات السكان يوضح) ١( رقم الجدول بان علما

Zone 
area pop 

Water 

Consumption
Qav  Qmd  Qhr  

HectaresCapita (L/Capita/day)(L/s) (L/s) (L/s) 

1  28.7 20000 150 34.72 55.56 86.81 

2  30.1 10000 150 17.36 27.78 43.40 

Total 58.8 30000  52.08 83.33 130.21 

 

  الحالي الوقت في المياه من والاستهلاكات السكان يوضح) ٢( رقم الجدول

Zone 
area pop 

Water 

Consumption
Qav  Qmd  Qhr  

HectaresCapita (L/Capita/day)(L/s) (L/s) (L/s) 

1  28.7 15000 150 26.04 41.67 65.10 

2  30.1 5000 150 8.68 13.89 21.70 

Total 58.8 20000  34.72 55.56 86.81 
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  إنترناشيونال كيمونكس   مصر في الصحي والصرف الشرب مياه قطاع دعم مشروع

 

 ٤٧  في تصميم شبكات مياه الشرب   (WaterCAD V8i)استخدام برنامج 

 

  

دام برنامج باستخ تصميم شبكه التغذية بالمياهمشروع كامل ل
WaterCAD 

  إعداد البياناتمرحلة : أولا

 ٢.٧و يزداد بمعدل  ٢٠١١نسمة لسنة  ١٠٠٠٠ جديدة ةيبلغ عدد سكان مدين  %
=  للمدن الجديدة اليوميالاستهلاك  متوسطعلما بأن  ٢٠٥١حتى سنة الهدف سنويا 
 يوم  والمطلوب /ف/ل ٢٨٠

  .ام الطريقة الحسابيةباستخد ٢٠٥١،  ٢٠٣١عدد السكان المتوقع عام  حساب -
 ٢٠٥١و  ٢٠٣١لعامي  ستهلاكحساب الا -

  .متوسط الاستهلاك اليومي  - ١
 .أقصى استهلاك شهري - ٢
 .أقصى استهلاك يومي - ٣
 .أقصى استهلاك ساعة - ٤

  حساب السكان -١

  :باستخدام الطريقة الحسابية

PN  =  P0  +  KA (  TN  ‐  T1  ) x  P0  

apitaC   =  15400    0    0000000  +  0.027 (  20  ) x  1=  1  2031P 

P2051  =  10000  +  0.027 (  40  ) x  10000      =  20800   Capita 
  ٢٠٥١  ٢٠٣١  ٢٠١١  ةالســـــــــــــنـــ

  ٢٠٨٠٠  ١٥٤٠٠  ١٠٠٠٠  )نسمة ١٠٠٠(متوسط عدد السكان 

  



  إنترناشيونال كيمونكس   مصر في الصحي والصرف الشرب مياه قطاع دعم مشروع

 

 ٤٨  في تصميم شبكات مياه الشرب   (WaterCAD V8i)استخدام برنامج 

 

  

  

  :الاستهلاكحساب  -٢

  المرحلة الأولى( ٢٠٣١عام  الاستهلاكحساب(  

=   دة في معدلات الاستهلاكنسبة الزيا









125.0
2011

125.0
2031

)(

)(
1

P

P ×100  

=   نسبة الزيادة في معدلات الاستهلاك









125.0

125.0

)10000(

)15400(
1 ×100  = 5.54 %  

  يوم /ف/ل ٢٩٦=   ٢٨٠  × ٠.٠٥٥٤+  ٢٨٠= متوسط الاستهلاك اليومي للفرد  
  ٢٤/ (١٥٤٠٠× ٢٩٦= متوسط الاستهلاك اليوميX٦٠X ث /ل  ٥٢.٧٦) =  ٦٠ 
    ٢٤/ (١٥٤٠٠×٢٩٦× ١.٢٥= أقصى استهلاك شهريX٦٠X ث / ل  ٦٥.٩٠) = ٦٠  

      ٢٤/ (١٥٤٠٠×٢٩٦× ١.٦٠= أقصى استهلاك يوميX٦٠X ث / ل  ٨٤.٤)=  ٦٠  

      ث/ ل  ١٣١.٩) =  ٦٠× ٦٠×٢٤/ (١٥٤٠٠×٢٩٦× ٢.٥٠=أقصى استهلاك ساعة  
   

  المرحلة الثانية( ٢٠٥١عام  الاستهلاكحساب(  

= ادة في معدلات الاستهلاك  نسبة الزي









125.0
2011

125.0
2051

)(

)(
1

P

P ×100  

=   الاستهلاكالزيادة في معدلات نسبة 









125.0

125.0

)10000(

)20800(
1 ×100  =9.60 %  

  يوم/ف/ل ٣٠٧=   ٢٨٠  × ٠.٠٩٦+  ٢٨٠= متوسط الاستهلاك اليومي للفرد  
  ث / ل ٧٣.٩) =  ٦٠× ٦٠×٢٤/ (٢٠٨٠٠×٣٠٧= متوسط الاستهلاك اليومي  
 ث / ل ٩٢.٤=  ) ٦٠× ٦٠×٢٤/ (٢٠٨٠٠×٣٠٧×١.٢٥= قصى استهلاك شهري أ  
     ث / ل  ١١٨.٢ = ) ٦٠× ٦٠×٢٤/ (٢٠٨٠٠×٣٠٧× ١.٦٠= أقصى استهلاك يومي  
    ث / ل  ١٨٤.٨) =  ٦٠× ٦٠×٢٤/ (٠٢٠٨٠×٣٠٧× ٢.٥٠=  أقصى استهلاك ساعة  



  إنترناشيونال كيمونكس   مصر في الصحي والصرف الشرب مياه قطاع دعم مشروع

 

 ٤٩  في تصميم شبكات مياه الشرب   (WaterCAD V8i)استخدام برنامج 

 

  

 ملاحظات

مع  (Qav2051) لتصميم الشبكة سيتم إدخال التصرف المتوسط لسنة الهدف .١
وذلك لتصميم ) Pattern(إدخال معاملات الاستهلاك للساعات المختلفة 

 الشبكة والطلمبات المطلوبة مستقبلا

عمل سيناريوهين احدهما بخزان عالي وأخر بدون خزان  ويتم في المعتاد .٢
  .عالي والمقارنة بينهما فنيا واقتصاديا لاختيار الحل الأفضل

لشبكات الصغيرة المستوية يكون تصميم الشبكة بدون مع العلم انه في حالة ا
خزان عالي  أفضل أما في حالة الشبكات الكبيرة يكون للخزان العالي عدة 

تثبيت , تثبيت التصرفات من الطلمبات وتقليل سعاتها, تجانس الأقطار(فوائد 
  ).الضاغط المطلوب منها

 يم الطلمبات الحاليةيتم عمل سيناريو إضافي للفترة التصميمية الأولى لتصم .٣

 يتم اختبار الشبكة في حالة الحريق للتأكد من أنها مستوفية لمتطلبات الحريق .٤
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  إنترناشيونال كيمونكس   مصر في الصحي والصرف الشرب مياه قطاع دعم مشروع

 

 ٥٣  في تصميم شبكات مياه الشرب   (WaterCAD V8i)استخدام برنامج 

 

Label Elevation (m) Base Flow (l/s) 

J-1 10.48 5.46 

J-2 10.47 8.02 

J-3 10.43 10.47 

J-4 10.36 5.93 

J-5 10.42 9.37 

J-6 9.77 7.54 

J-7 10.05 9.18 

J-8 10.4 11.68 

J-9 10.66 9.78 

J-10 10.56 6.65 

J-11 10.52 9.51 

J-12 10.6 10.18 

J-13 10.65 6.54 

J-14 10.7 11.91 

J-15 10.72 14.55 

J-16 10.98 16.34 

J-17 10.59 15.32 

J-18 10.42 16.32 

                                           

  جدول رقم ا

  )يتم إدخالها لنقاط الاتصال التييوضح البيانات (

   



  إنترناشيونال كيمونكس   مصر في الصحي والصرف الشرب مياه قطاع دعم مشروع

 

 ٥٤  في تصميم شبكات مياه الشرب   (WaterCAD V8i)استخدام برنامج 

 

 
 بيانات المدخلات الخاصة بالمواسير -٢

  :آما يليللبرنامج وإدخالها يتم فرض أقطار ابتدائية : ملحوظة

  
Label Length (m) Diameter (mm) 
P-1 17.5 200 

P-2 18.5 200 

P-3 66.5 200 

P-4 120.5 200 

P-5 172 200 

P-6 63.5 200 

P-7 138.5 200 

P-8 72 200 

P-9 99 200 

P-10 116 200 

P-11 67 200 

P-12 108 200 

P-13 95 200 

P-14 61 200 

P-15 31.5 200 

P-16 31.5 200 

P-17 77.5 200 

P-18 61.5 200 

P-19 63 200 

P-20 77.5 200 

P-21 119 200 

P-22 98 200 

P-23 78 200 

P-24 120 200 

P-25 97.5 200 

P-26 73 200 

P-27 62 200 



  إنترناشيونال كيمونكس   مصر في الصحي والصرف الشرب مياه قطاع دعم مشروع

 

 ٥٥  في تصميم شبكات مياه الشرب   (WaterCAD V8i)استخدام برنامج 

 

P-28 67.5 200 

P-29 35.5 200 

  ٢جدول رقم 

  )يوضح البيانات التي يتم إدخالها للمواسير(

حيث يتم وضع قطر افتراضي لجميع المواسير ثم التأكد من صلاحية ذلك القطر من خلال 
  نتائج التحليل الهيدروليكي وإعادة التحليل الهيدروليكي 

 :ةملاحظ

 المواسير لكافة بالنسبة =130  وليامز لهازين  Cتم هنا اخذ معامل -

 

 :يانات المدخلات الخاصة بمصدر المياه ب -٣

Label  Elevation (m) 

R-1 10.75 

  ٣جدول رقم 

  )يوضح البيانات التي يتم إدخالها لمصدر المياه(                    

  

 :بيانات المدخلات الخاصة بالطلمبات  -٤

Design point
Type   Elevation (m)  Label  

Q= Qmhr (L/s) pressure

184.8  30  One point10.75 Pump‐1 

  ٤جدول رقم 

  )يوضح البيانات التي يتم إدخالها للطلمبات (
  



  إنترناشيونال كيمونكس   مصر في الصحي والصرف الشرب مياه قطاع دعم مشروع

 

 ٥٦  في تصميم شبكات مياه الشرب   (WaterCAD V8i)استخدام برنامج 

 

  وتصحيح الأقطار  مراجعه بيانات المخرجات -ب

  المخرجات الخاصة بالمواسير -١

Label Length 
(m) 

Diameter 
(mm) 

Head 
Loss (m) 

Head Loss 
Gradient 
(m/km) 

Velocity (m/s) 

1‐P 17.5 200 2.53 144.342 5.88 
2‐P 18.5 200 2.67 144.342 5.88 
3‐P 66.5 200 2.93 44.002 3.1 

P‐4 120.5 200 1.15 9.583 1.36 
P‐5 172 200 0.26 1.52 0.5 
P‐6 63.5 200 0.04 0.636 0.31 
P‐7 138.5 200 0.01 0.061 0.09 
P‐8 72 200 0.01 0.164 0.15 
P‐9 99 200 0.13 1.277 0.46 
P‐10 116 200 0.33 2.874 0.71 
P‐11 67 200 0.25 3.757 0.82 
P‐12 108 200 0.62 5.748 1.03 
13‐P 95 200 3.05 32.077 2.61 

P‐14 61 200 0.69 11.236 1.48 
P‐15 31.5 200 0.01 0.348 0.23 
P‐16 31.5 200 0.28 8.752 1.29 
P‐17 77.5 200 0.02 0.277 0.2 
P‐18 61.5 200 0.1 1.635 0.52 
P‐19 63 200 0.06 1.005 0.4 
P‐20 77.5 200 0.01 0.107 0.12 
P‐21 119 200 0.35 2.913 0.71 
P‐22 98 200 0.13 1.377 0.48 
P‐23 78 200 0 0.002 0.01 
P‐24 120 200 0.57 4.749 0.93 
P‐25 97.5 200 0.2 2.033 0.59 
P‐26 73 200 0 0.043 0.07 
P‐27 62 200 0 0 0.01 
P‐28 67.5 200 0.58 8.522 1.28 

  ٥جدول رقم 

  )بالمواسير  الخاصةيوضح نتائج التحليل الهيدروليكي و(

   



  إنترناشيونال كيمونكس   مصر في الصحي والصرف الشرب مياه قطاع دعم مشروع

 

 ٥٧  في تصميم شبكات مياه الشرب   (WaterCAD V8i)استخدام برنامج 

 

المواسير التي تم فرضها للبرنامج من البداية يوجد بها  أنمن خلال النتائج السابقة يتضح 
ث لذلك يتم زيادة /م ١.٥السرعة اكبر    p‐  p‐1 , p‐2 , ٣ p‐13 , بعض المشاكل حيث فى

  :تشغيل البرنامج لتصبح النتائج كالتالي  ةدالأقطار لتقليل السرعة وإعا

Label Length 
(m) 

Diameter 
(mm) 

Head 
loss (m) 

Head loss 
Gradient 
(m/km) 

Velocity 
(m/s) 

P-1 17.5 450 0.05 2.779 1.16 

P-2 18.5 450 0.05 2.779 1.16 

P-3 66.5 300 0.39 5.894 1.35 

P-13 95 300 0.44 4.637 1.19 

  ٦ جدول رقم

  )بالمواسير بعد زيادة القطر الخاصةيوضح نتائج التحليل الهيدروليكي (

   



  إنترناشيونال كيمونكس   مصر في الصحي والصرف الشرب مياه قطاع دعم مشروع

 

 ٥٨  في تصميم شبكات مياه الشرب   (WaterCAD V8i)استخدام برنامج 

 

  

  المخرجات الخاصة بنقاط الاتصال بعد تعديل الأقطار -٢

Label Pressure Head (m) 

J-1 30.1 

J-2 29.7 

J-3 28.7 

J-4 28.5 

J-5 28.4 

J-6 29 

J-7 28.7 

J-8 28.5 

J-9 28.6 

J-10 29 

J-11 29.6 

J-12 29 

J-13 28.9 

J-14 28.6 

J-15 28.3 

J-16 27.9 

J-17 28.2 

J-18 28.4 

  ٧جدول رقم 

  )بنقاط الاتصال الخاصةيوضح نتائج الضغوط و(

متر وهذا ناتج أن  ٢٥م اى أنها اكبر من ٢٨من الملاحظ أن اقل ضغوط بالشبكة في حدود 
تشغيل لنحصل على النتائج  ةوإعادمتر   ٣ضاغط الطلمبة كبير نوعا ما ويمكن تقليله بقيمه 

  التالية 



  إنترناشيونال كيمونكس   مصر في الصحي والصرف الشرب مياه قطاع دعم مشروع

 

 ٥٩  في تصميم شبكات مياه الشرب   (WaterCAD V8i)استخدام برنامج 

 

  

Label Pressure Head (m) 

J-1 27.1 

J-2 26.7 

J-3 25.7 

J-4 25.5 

J-5 25.4 

J-6 26 

J-7 25.7 

J-8 25.5 

J-9 25.6 

J-10 26 

J-11 26.6 

J-12 26 

J-13 25.9 

J-14 25.6 

J-15 25.3 

J-16 25 

J-17 25.2 

J-18 25.4 

  ٨جدول رقم 

  )ةبنقاط الاتصال وذلك بعد تقليل ضاغط الطلمب الخاصةيوضح نتائج الضغوط و(

  

 



  إنترناشيونال كيمونكس   مصر في الصحي والصرف الشرب مياه قطاع دعم مشروع

 

 ٦٠  في تصميم شبكات مياه الشرب   (WaterCAD V8i)استخدام برنامج 

 

  )دراسة الشبكة بوجود خزان عالي(السيناريو الثاني 

حيث يتم إضافة خزان عالي إلى  EXTENDED PERIOD  ةوفي هذه الحالة يتم استخدام حال
     على نقاط الاتصال وسطالمت بتوزيع التصرف الشبكة كذلك يتم إدخال أنماط استهلاك  و

  :إدخال البيانات   - أ

 :بنقاط الاتزان الخاصةبيانات المدخلات  -١

Label Elevation (m) Base Flow (l/s) 

J-1 10.48 2.18 

J-2 10.47 3.21 

J-3 10.43 4.19 

J-4 10.36 2.37 

J-5 10.42 3.75 

J-6 9.77 3.02 

J-7 10.05 3.67 

J-8 10.4 4.67 

J-9 10.66 3.91 

J-10 10.56 2.66 

J-11 10.52 3.8 

J-12 10.6 4.07 

J-13 10.65 2.62 

J-14 10.7 4.76 

J-15 10.72 5.82 

J-16 10.98 6.54 

J-17 10.59 6.13 

J-18 10.42 6.53 

  ٩جدول رقم 

  )يوضح البيانات التي يتم إدخالها لنقاط الاتصال(

 



  إنترناشيونال كيمونكس   مصر في الصحي والصرف الشرب مياه قطاع دعم مشروع

 

 ٦١  في تصميم شبكات مياه الشرب   (WaterCAD V8i)استخدام برنامج 

 

 بيانات المدخلات الخاصة بالمواسير -٢

  فرض أقطار ابتدائية وإدخالها للبرنامج يتم : ملحوظة

Label Length (m) Diameter (mm) 
P-1 17.5 200 
P-2 18.5 200 
P-3 66.5 200 
P-4 120.5 200 
P-5 172 200 
P-6 63.5 200 
P-7 138.5 200 
P-8 72 200 
P-9 99 200 

P-10 116 200 
P-11 67 200 
P-12 108 200 
P-13 95 200 
P-14 61 200 
P-15 31.5 200 
P-16 31.5 200 
P-17 77.5 200 
P-18 61.5 200 
P-19 63 200 
P-20 77.5 200 
P-21 119 200 
P-22 98 200 
P-23 78 200 
P-24 120 200 
P-25 97.5 200 
P-26 73 200 
P-27 62 200 
P-28 67.5 200 

P-29 35.50 يتم تصميم قطر افتراضى لها 

  ١٠جدول رقم 

  )بالمواسير  الخاصةح نتائج التحليل الهيدروليكي ويوض(

   



  إنترناشيونال كيمونكس   مصر في الصحي والصرف الشرب مياه قطاع دعم مشروع

 

 ٦٢  في تصميم شبكات مياه الشرب   (WaterCAD V8i)استخدام برنامج 

 

  بالخزان العلوي  الخاصةوهى  ٢٩لتصميم الماسورة رقم 

  ث/ل ٦٦.٦= ١١٨.٢-١٨٤.٨= Qmd ‐ Qmhr= يتم تقدير التصرف الخارج من الخزان  -

  مم ٣٠٠=ث يصبح القطر /م ١.٠٠=وبفرض ان السرعة 

 أنماط الاستهلاك  -٣

  (pattern)تهلاك خلال اليوم من الاستهلاك اليومي المتوسطجدول يوضح نسب نمط الاس

  ١٢:٠٠  ١٠:٠٠ ٨:٠٠  ٦:٠٠ ٤:٠٠ ٢:٠٠ ٢٤:٠٠  الساعة

  ٢.٥  ٢.٢٣  ١.٧٣  ١.٤٠  ١.٠٩  ٠.٨٥  ٠.٧٠ النسبة من المتوسط
  ٢٤:٠٠  ٢٢:٠٠  ٢٠:٠٠  ١٨:٠٠  ١٦:٠٠  ١٤:٠٠  ١٢:٠٠  الساعة

  ٠.٧٠  ١.٢٠  ١.٦٥  ١.٧٥  ١.٨  ٢.٣  ٢.٥  النسبة من المتوسط

  ١١دول رقم ج

  )يوضح نمط الاستهلاك(

 :بمصدر المياه  الخاصةبيانات المدخلات  -٤

Label  Elevation (m) 

R-1  10.75 

  ١٢جدول رقم 

  )يوضح البيانات التى يتم إدخالها لمصدر المياه(

 :بالطلمبات  الخاصةبيانات المدخلات  -٥

Design Point  
Type of def. Elevation (m) Label  

Q= Qmd (L/s) pressure 

٣٠  ١١٨.٢  One point ١٠.٧٥  Pump-1 

  ١٣جدول رقم 

  )يوضح البيانات التى يتم إدخالها للطلمبات (



  إنترناشيونال كيمونكس   مصر في الصحي والصرف الشرب مياه قطاع دعم مشروع

 

 ٦٣  في تصميم شبكات مياه الشرب   (WaterCAD V8i)استخدام برنامج 

 

  

 :بالخزان العلوي  الخاصةبيانات المدخلات  -٦

  :يتم تقدير حجم الخزان وارتفاعه كما يلي 

  ساعات  ٨- ٤= (تقدير حجم الخزان ((Qmh ‐ Qmd) *  ساعات عادةً ٦وتؤخذ 

      Volume =66.6(l/s) *6(hr)*3.6=1438.6m3  
  متر  ١٧.٥متر يصبح القطر  ٦وبأخذ العمق 

  يتم تقدير منطقة خدمة الخزان العالي من نسبة التصرف الخارج منه إلى التصرف
) ابعد نقطة وأعلى نقطة(ثم نقدر النقطة الحرجة  ٠.٣٦=  ٦٦.٦/١٨٤.٨= الكلى 

م وعند  ٢٩٠وهى تبعد مسافة  ‐١٦Jداخل منطقة الخدمة ونجد هنا أنها النقطة 
  م ٩.٢٠م والخزان عند منسوب  ١١.٠٠منسوب 

)+ منسوب الخزان –منسوب النقطة = (الارتفاع الأدنى للمياه بالخزان من الأرض   
ضغط المتبقي (٢٥))+ كم/م ٣نفرض انه (ميل هيدروليكي * طول المواسير( الفواقد

م  من الأرض  ٢٧.٦٧= ٢٥+٠.٠٠٣*٢٩٠+٩.٢٠- ١١)=الأدنى المطلوب للنقطة
  م ٢٨ويؤخذ 

  ١٤جدول رقم 

  )يوضح البيانات التي يتم إدخالها للخزان العالي (

 

Label Elevation (m) Base (m) 

T-1 ٣٧.٢٠ ٩.٢٠ 

Maximum (m) Initial (m) Minimum (m) Diam. (m) 

١٧.٥ ٣٨.٢٠  ٤١.٢٠ ٤٤.٢٠  



  إنترناشيونال كيمونكس   مصر في الصحي والصرف الشرب مياه قطاع دعم مشروع

 

 ٦٤  في تصميم شبكات مياه الشرب   (WaterCAD V8i)استخدام برنامج 

 

وتصحيح الأقطار  مراجعه بيانات المخرجات -ب  

Label Length 
(m) 

Diameter 
(mm) 

Head 
Loss (m) 

Head Loss 
Gradient 
(m/km) 

Velocity (m/s) 

P-1 17.5 200 1.04 59.15 3.6 

P-2 18.5 200 1.09 59.15 3.6 

P-3 66.5 200 1.14 17.189 1.9 

P-4 120.5 200 0.35 2.901 0.7 

P-5 172 200 0 0.019 0.1 

P-6 63.5 200 0.01 0.137 0.1 

P-7 138.5 200 0.5 3.583 0.8 

P-8 72 200 0.46 6.426 1.1 

P-9 99 200 0.08 0.817 0.4 

P-10 116 200 0.02 0.194 0.2 

P-11 67 200 0.06 0.923 0.4 

P-12 108 200 0.22 2.053 0.6 

P-13 95 200 1.23 12.932 1.6 

P-14 61 200 0.27 4.47 0.9 

P-15 31.5 200 0.01 0.223 0.2 

P-16 31.5 200 0.08 2.689 0.7 

P-17 77.5 200 0 0.058 0.1 

P-18 61.5 200 0.04 0.731 0.3 

P-19 63 200 0.01 0.178 0.2 

P-20 77.5 200 0.01 0.184 0.2 

P-21 119 200 0.04 0.347 0.2 

P-22 98 200 0 0.011 0.0 

P-23 78 200 0.1 1.235 0.5 

P-24 120 200 0.12 1.015 0.4 

P-25 97.5 200 0.01 0.127 0.1 

P-26 73 200 0.06 0.859 0.4 

P-27 62 200 0 0.001 0.0 

P-28 67.5 200 0.19 2.878 0.7 

P-29 35.5 300 0.11 3.055 0.95 

  ١٥جدول رقم 

  )بالمواسير  الخاصةيوضح نتائج التحليل الهيدروليكي و(
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  إنترناشيونال كيمونكس   مصر في الصحي والصرف الشرب مياه قطاع دعم مشروع

 

 ٦٦  في تصميم شبكات مياه الشرب   (WaterCAD V8i)استخدام برنامج 

 

 إلىالخزان يحتاج   أنيتضح   السابقة نافذةمن خلال قراءه منحنى الخزان من ال -
التصميم الأنسب حيث انه لم يمتلئ الخزان بالكامل  إلىبعض التعديلات للوصول 

 فيوهى ساعات ينبغي  ٢٠ إلى ١٣وكذلك بقاؤه فارغا خلال الساعات من 
 قوم الخزان بتغذيه الشبكةي أنمعظمها 

  
وذلك قبل تصحيح وضع  عند أقل ضغط خلال اليوم المخرجات الخاصة بنقاط الاتصال -١

  : الخزان

Label Pressure Head (m) 

J-1 18.34 

J-2 17.81 

J-3 16.48 

J-4 16.26 

J-5 16.15 

J-6 16.78 

J-7 16.51 

J-8 16.25 

J-9 16.21 

J-10 16.43 

J-11 16.83 

J-12 16.64 

J-13 16.5 

J-14 16.21 

J-15 16.04 

J-16 15.69 

J-17 15.98 

J-18 16.15 

  ١٧جدول رقم 

  )بنقاط الاتصال قبل تصحيح الخزان الخاصةيوضح نتائج الضغوط و(



  إنترناشيونال كيمونكس   مصر في الصحي والصرف الشرب مياه قطاع دعم مشروع

 

 ٦٧  في تصميم شبكات مياه الشرب   (WaterCAD V8i)استخدام برنامج 

 

  :ةملحوظ

فقد اثر على الضغوط بنقاط الاتصال حيث , نتيجة لان الخزان يحتاج إلى بعض التعديلات
م أثناء ساعة الذروة وبعد عده محاولات  ٢٥اقل ضغط مطلوب وهو نقصت الضغوط عن 

وحتى لا يغذى منطقه  تقليل حتى يتثنى ملئه كاملا إلىللتصميم تبين ان ارتفاع الخزان يحتاج 
  .اكبر من المخصصة له

   

: عليه تم تعديل المدخلات كالتالي وبناءً  

 :بالخزان العلوي  الخاصةبيانات المدخلات  -١

Label Elevation (m) Base (m) 

T-1 ٣٥.٨٠ ٩.٢٠ 

Maximum (m) Initial (m) Minimum (m) Diam. (m) 

١٧.٥٠ ٣٦.٨٠  ٣٩.٢٥ ٤٢.٣٠  

  ١٨جدول رقم 

  )يوضح المدخلات المعدلة للخزان العلوي(

   



  إنترناشيونال كيمونكس   مصر في الصحي والصرف الشرب مياه قطاع دعم مشروع

 

 ٦٨  في تصميم شبكات مياه الشرب   (WaterCAD V8i)استخدام برنامج 

 

نتائج المخرجات بعد تعديل مدخلات الخزان العلوي  تشغيل البرنامج أصبحت ةوبعد إعاد
:والطلمبات كالتالي  

  )١٦.٠٠(المخرجات الخاصة بنقاط الاتصال عند الساعة الحرجة  -١

Label Pressure Head (m) 
J-1 27.67 

J-2 27.36 

J-3 26.58 

J-4 26.47 

J-5 26.38 

J-6 27.02 

J-7 26.74 

J-8 26.45 

J-9 26.32 

J-10 26.5 

J-11 26.75 

J-12 26.61 

J-13 26.5 

J-14 26.31 

J-15 26.2 

J-16 25.89 

J-17 26.21 

J-18 26.38 

  ١٩جدول رقم 

يوضح نتائج الضغوط عند نقاط الاتصال بعد  تعديل مدخلات الخزان العالي (

  )والطلمبات
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  إنترناشيونال كيمونكس   مصر في الصحي والصرف الشرب مياه قطاع دعم مشروع

 

 ٧٠  في تصميم شبكات مياه الشرب   (WaterCAD V8i)استخدام برنامج 

 

  اختبار الحريق -رابعا 

تم فرض السيناريو الثاني والذي يحتوى على خزان عالي هو الأمثل وسيتم إجراء تحليل 
  مدخلات الحريق  ةبنفس الخصائص التي تم ذكرها لكن بإضافعليه الحريق 

  بيانات المدخلات

App. Fire Flow 
Min. Zone 

Pressure (m) 
Residual 

Pressure (m) 
Fire Flow Upper 

Limit (l/s) 
Needed Fire 
Flow (l/s) 

Add to base 
demand=Qmd2051 

15 14 32 25 

  ٢٠جدول رقم 

  )بتحليل الحريق الخاصةت يوضح نتائج المدخلا(

  ويتم اختيار عمل التحليل لجميع النقاط للتأكد من استيفائها لمحددات الحريق

Q/one junction =Qmd2051/no of junctions=118.2/18=6.56 L/s 

   



  إنترناشيونال كيمونكس   مصر في الصحي والصرف الشرب مياه قطاع دعم مشروع

 

 ٧١  في تصميم شبكات مياه الشرب   (WaterCAD V8i)استخدام برنامج 

 

 بيانات المخرجات

Label
Satisfies Fire 

Flow 
Constraints? 

Available 
Fire Flow 

(l/s) 

Calc Residual 
Pressure (m) 

Min Zone 
Pressure (m) 

Min Zone 
Junction 

J-1 TRUE 32 25.4 23.97 J-16 

J-2 TRUE 32 24.97 23.82 J-16 

J-3 TRUE 32 23.92 23.37 J-16 

J-4 TRUE 32 23.62 23.32 J-16 

J-5 TRUE 32 23.59 23.31 J-16 

J-6 TRUE 32 24.12 23.3 J-16 

J-7 TRUE 32 23.97 23.29 J-16 

J-8 TRUE 32 23.75 23.28 J-16 

J-9 TRUE 32 23.64 23.37 J-16 

J-10 TRUE 32 23.76 23.41 J-16 

J-11 TRUE 32 24.15 23.54 J-16 

J-12 TRUE 32 24.05 23.51 J-16 

J-13 TRUE 32 23.91 23.48 J-16 

J-14 TRUE 32 23.68 23.39 J-16 

J-15 TRUE 32 23.58 23.32 J-16 

J-16 TRUE 32 23.24 23.62 J-17 

J-17 TRUE 32 23.47 23.29 J-16 

J-18 TRUE 32 23.65 23.3 J-16 

  ٢١جدول رقم 

  )يوضح نتائج المخرجات والخاص بتحليل الحريق(



  إنترناشيونال كيمونكس   مصر في الصحي والصرف الشرب مياه قطاع دعم مشروع

 

 ٧٢  في تصميم شبكات مياه الشرب   (WaterCAD V8i)استخدام برنامج 

 

 )(الخانة الخاصة بتحقيق الشبكة للاشتراطات الخاصة بالحريقإلى وبالنظر  Satisfies  Fire 

Flow  Constraints?)لمتاح للحريق حيث انه التصرف ا)(available  fire  flow  اكبر من
 Needed(ث /ل ٢٥ Fire  Flow ( ث /ل ٣٢ويكون أقصى رقم يمكن أن يخرج هو)Fire 

Flow  Upper  Limit (( فنجد أنها متحققة في جميع النقاط كما أن الكمية المياه المتوفرة
)(available  fire  flow ٣٢(الحريق وصلت إلى أقصى تصرف يمكن أن يخرج من حنفية 
 Fire)) ث/ل Flow  Upper  Limit)  مع وجود ضغط متبقي(Calc  Residual 

Pressure) (واقل ضغط بالمنطقة ) م١٤(اكبر من المطلوبMin  Zone  Pressure ( اكبر
 وذلك بجميع النقاط ) م٢٥(من المطلوب 

   .متطلبات الحريق وبالتالي تكون آمنةب تفيوبالنظر إلى ما سبق نجد أن الشبكة 




